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1 Data/Information in the GIS Database  

This environmental GIS database was prepared in the Master Plan Study on 
Integrated Environmental Management in Baku City in Azerbaijan Republic, under 
the Development Study Programme of the Japan International Cooperation Agency 
(JICA). In this chapter, the team introduces regarding a GIS manual, a database 
management, a GIS data book and a homepage of BCE.  

1.1 GIS Manual 

This section will only refer to the important aspects that were considered in the period 
of training. The other details of utilisation of Arc View, is explained in the manuals 
“Using ArcView GIS”. 

1.1.1 Introduction 

ArcView is a powerful, easy-to-use tool that brings geographic information to your 
desktop. ArcView gives you the power to visualise, explore, query and analyze data 
spatially. 

ArcView is produced by Environmental Systems Research Institute (ESRI), the 
maker of ARC/INFO.  

1.1.2 Working with Project 

A project is the file in which work you do in ArcView is stored. A project typically 
contains all the view, tables, charts, layouts, and scripts that you use for a particular 
ArcView application. In this way, your work is stored in one convenient place. The 
next time you want to work on this application you can simply open this project file 
in ArcView and all the components you need are available for you to use. Project 
files have an [.apr] extension. 

a. Creating a project 

1. Start ArcView, and from the File menu, choose New Project 

 

2. ArcView creates a new project called Untitled and opens the project window.  
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1.1.3 Management of a Project 

a. Opening an existing project 

1. From the File menu, choose Open Project. 

 
 

2. ArcView displays the Open Project dialog box where you specify the name 
and location of the project you want to open. 

b. Copying a project 

1. From the File menu, choose Save Project As. ArcView displays a dialog box 
in which you give the active project a different name and save it. 

c. Renaming or deleting a project 

1. Close the project. In a multi-user environment, confirm that all users have 
closed the project. 

2. Use your system's file management application, desktop editing technique or 
the appropriate rename or delete command to work with the ArcView [.apr] 
file. If you are renaming the project, the new name can be up to eight 
characters long but can't contain spaces. 

1.1.4 Creating and using maps 

a. What is a view and theme? 

A view is an interactive map that lets you display, explore, query and analyze 
geographic data in ArcView. Views are saved in the ArcView project you are 
currently working with. A view defines the geographic data that will be used and how 
it will be displayed, but it doesn't contain the geographic data files themselves. 
Instead, a view references these source data files. This means that a view is dynamic, 
because it reflects the current status of the source data. If the source data changes, a 
view that uses this data will automatically reflect the change the next time the view is 
drawn.  

A view is actually a collection of themes. A theme represents a distinct set of 
geographic features in a particular geographic data source. For example, a view 
showing a country might have one theme representing cities, one theme representing 
roads, one representing rivers, etc. 
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b. Creating a new view and adding a theme to a view 

1. On the Project window, click the Views button and then press the New button. 
A new, empty view will appear in your project. 

 

 
 

2. Add themes to the view for each spatial data source you want to display. You 
can also add themes based on tabular data such as street addresses or XY 
coordinates. Click in the add button. 

 

 
 

3. ArcView displays the Add theme dialog box where you specify the name and 
location of the theme you want to add. 

4. Click check boxes of the theme names to drawn in your view. These check 
boxes let you toggle themes on and off in the view. 
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1.1.5 Laying out and printing maps 

a. Creating a layout 

A layout is a map that lets you display views, charts, tables, imported graphics, and 
graphic primitives. The layout is used to prepare these graphics for output from 
ArcView. The layout defines what data will be used for output and how they will be 
displayed. The layout can be dynamic because it allows you to make specific graphics 
live. When a graphic is live, it reflects the current status of the data. For example, if 
the data in a view changes, the layout automatically reflects the change. 

1. From the file menu selects Layout. 
 

 
 

2. Select the paper size, orientation and then Click ok button. 
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3. Add legend, scale bar, title, graphic and when you are finally satisfied with 
your layout you can send it to a printer. 

 

 
 
b. Exporting a layout 

You can export a layout to a file in any of a number of supported output formats. 
ArcView exports to the following formats:  

• Placeable Windows Metafile 
• Windows Metafile 
• Windows Bitmap 
• Encapsulated PostScript - New 
• Encapsulated PostScript - Old 
• Adobe Illustrator 
• CGM Binary 
• CGM Character 
• CGM Clear Text 
• JPEG 

 
1. Select the layout you want to export 
2. From de file menu select Export. 
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3. ArcView displays the Export dialog box where you specify the name and 
location of the layout to export, and select a file format from the List Files of 
Type. 

 

 
  

1.1.6 Working with tabular data 

a. What is a table? 

A table lets you work with data from a tabular data source in ArcView. You can bring 
data from almost any tabular data source in your organisation into ArcView as tables. 
Then you can add data from these tables to maps, and symbolise, query and analyze 
this data geographically.  

An ArcView table references the tabular data source it represents, but doesn't contain 
the tabular data itself. This means that tables are dynamic, because they reflect the 
current status of the source data they are based on. If the source data changes, a table 
based on this data will automatically reflect the change the next time you open the 
project containing this table. You can also choose Refresh from the Table menu to 
refresh the table at any time to see the current state of your source data. The 
definitions of tables you add to ArcView are saved in the project file you are 
currently working on. 
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You can create new tables in ArcView and type data values into them directly. You 
can also edit some tables, depending on the type of tabular data source they represent 
and whether you have write permission to them. See editing the values in a table. 

You can add dBASE, INFO, and tab or comma delimited text files into ArcView as 
tables. These data sources can contain any data that you wish to work with in 
ArcView. For example, these tables might contain additional information about the 
features displayed on a view.  

From ArcView, you can connect to a database server, such as Oracle or Sybase, and 
run an SQL query to retrieve records from it as a table. ArcView stores the definition 
of the SQL query you used, not the records themselves. See Connecting to a database 
to create a table. 

b. Management of a Table 

b.1 Opening a theme’s table 

1. Open the view containing the theme. 
2. Click on the theme to make it active and Click the Open Theme Table button 

in the View button bar. 

 
 

3. When you open a theme's table, it will appear in the list of tables in the Project 
window in which case it can also be opened using the Open button on the 
Project window. 
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b.2 Adding a table into a project 

1. Select the table icon in the project windows and click the “Add” button. 
 

 
 

2. ArcView displays the [Add Table] dialog box where you specify the name, 
type and location of the file to add a dBASE, INFO or delimited text file as a 
table in your project. 
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b.3 Creating a new table 

1. With the Tables icon selected, click the New button at the top of the Project 
window. 

 

 
 

2. Enter a name and a disk location for the dBASE file that ArcView will create 
to store the source data for the table. ArcView creates a new table and its 
name will appear in the list of tables in the project. ArcView names new 
tables in numerical order: Table1, Table2, Table3, etc.   

b.4 Editing a table 

1. Open the table you want to edit. 
2. From the Table menu, choose Start Editing. If you have write access to the 

data source, you will be allowed to edit the table. You can add or delete fields 
and records and edit the values in the table. 

 

 
 
b.5 Closing a table 

1. From the File menu, choose Close, or click the close control on the table's 
window. 

b.6 Deleting a table 

Click once on the table in the list in the Project window and choose Delete from the 
Project menu. You will be prompted to confirm deleting the table. Deleting a table 
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removes it from the project, but does not affect the tabular data source that the table is 
based on. 

b.7 Exporting a table 

1. Open the table you want to export. 
2. From the File menu, choose [Export] 

 

 
  

3. ArcView displays the [Export Table] dialog box where you specify the export 
format and then click the [OK] button. 

 

 

c. Join tables 

You can join a table to the active table based on the values of a common field found 
in both tables. Join establishes a one-to-one or many-to-one relationship between the 
destination table (the active table) and the source table (the table you are joining into 
the active table). Typically, the source table contains descriptive attributes of features 
that you wish to join into a theme's table so that you can symbolise, label, query and 
analyze the features in the theme using the data from your source table. 

c.1 Joining two tables 

1. Open the tables you wish to join. 
2. For example to join district population density with attribute of district 

boundary table. 
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3. Make the source table active (district population density). Click the name of 
the common field you wish to use, in this case (ID). 

 

 
 

4. Make the destination table (attribute of District boundary). Click the name of 
the common field you wish to use (ID). 

 

 
 

5. From the Table menu choose Join, or click the Join button. Now you have a 
table of district boundary with a population density. 

 

Join buttom 

Source table 

Destination table 
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Tables are joined based on a field that is found in both tables. The name of the field 
does not have to be the same in both tables, but the data type has to be the same. You 
can join; 

• Numbers to numbers 
• Strings to strings 
• Booleans to Booleans 
• Dates to dates. 

Any field can be chosen as the basis for a join, not just ones that uniquely identify 
geographic features.  

c.2 Why is the join option dimmed out when I try to join tables 

1. The problem may be because the source table already contains a join. For 
example, if you join table A to table B and then try to join table B to table C, 
the join option will appear dimmed out. To see if your source table already 
contains a join, make it active and look at the Remove All Joins option in the 
Table menu. If Remove All Joins is not dimmed out, your source table does 
contain one or more joins. 

To perform a join in this situation you can either choose Remove All Joins to 
remove any existing join(s) from your source table and then perform the join 
or export the source table into a new table, add that table into your project, 
then do the join. The latter option is more useful than the first because it 
ensures that all the data in your original table is joined to the destination table. 

To perform a join in this situation you can either choose Remove All Joins to 
remove any existing join(s) from your source table and then perform the join 
or export the source table into a new table, add that table into your project, 
then do the join. The latter option is more useful than the first because it 
ensures that all the data in your original table is joined to the destination table. 

The destination table (the table that is active when you choose Join) can 
contain existing joins. 

2. Join will also be dimmed out if the data types of the fields that you are joining 
are different. For example, trying to join tables on a zip code field that is of 
type number in one table and of type string in another table. The string field is 
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left justified while the number field is right justified. To resolve this issue, add 
a field to one of the tables that is of the appropriate type and use the calculator 
to add zip codes from the original field. 

3. Joins are also not possible if the source table is in edit mode. 

c.3 Editing joined data 

When editing a joined table, you can only edit the fields in the destination table. Edits 
to the fields from source tables must be performed directly on those tables. You can 
then use Refresh from the Table menu to show the changes in the joined table. 

c.4 How are joins saved 

When you save a project containing a join, ArcView saves the definition of the join 
rather than saving the joined data itself. The next time you open the project, ArcView 
rejoins any joined tables by reading their files from disk or re-executing the SQL 
queries they are based on. In this way, any changes to the source or destination tables 
that have taken place since they were last joined are automatically included in the 
project, and reflected in any views, tables, charts or layouts based on the joined data. 

Because joining tables has no effect on their physical files on disk, you don't need to 
have write permission to files to be able to join them in ArcView.  

If you want to make a new table on disk to permanently store the joined data, you 
choose Export from the Table menu. You would do this, for example, if you wanted 
to use the table in another application. 

To remove joined fields from a table you are working on, choose Remove All Joins 
from the Table menu. 

d. Spatial joins 

If you join two theme attribute tables together using their Shape field as the common 
field, ArcView automatically bases the join on the spatial relationship between the 
features in the two themes.  

d.1 Performing a spatial join 

For example you have a land use themes and district boundary themes, and if you 
want to know the land use type per each district. 

1. From the view, open the attribute tables of the themes you wish to join. In this 
case land use themes and district boundary themes. 

2. Make the source table active (District boundary). This is the table you wish to 
join to the other table. Click the Shape field’s name. 
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3. Make the destination table active (Land use). This is the table you wish to 
receive the values of the source table. Click the Shape field's name. 

 

 
 

4. From the Table menu choose Join, or click the Join button. The source table is 
joined to the destination table. The source table is closed automatically. 

A spatial join is similar to an attribute join; however it is based on the spatial 
relationship between the features in the two themes. For each feature 
represented in the destination table, ArcView looks to see if it has one of the 
following spatial relationships with any feature represented in the source 
table, and if it does, that feature's record from the source table is joined into 
the destination table: 

 
Shapes Point Line Polygon 

Point Nearest Nearest Inside 

Line Nearest Part of Inside 

Polygon n/a n/a Inside 
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When the spatial join is based on the 'nearest' relationship (i.e., neither of the 
two themes involved contains polygons and one of them contains points), 
ArcView adds a Distance field to the destination table. This field is 
automatically calculated by ArcView and contains the distance to the nearest 
feature represented in the source table for each feature represented in the 
destination table. The distance is calculated in the view’s map units. 

When the spatial join is based on the 'part of' relationship (i.e., both themes 
involved contain line features), the line features represented in the destination 
table have to be substrings of the line features represented in the source table 
to satisfy the spatial join. In other words, the lines in one theme are part of the 
lines in the other theme.  

e. Link two tables 

Join establishes a one-to-one or many-to-one relationship between the destination 
table and the source table. However in some situations you may want to establish a 
one-to-many relationship between the destination table and the source table.  

An example of a one-to-many relationship is a table of type of land use and the table 
of land use of the entire district. One type of land use is many in the entire district. 
You may want to select a specific type of land use in the entire district. 

1. From the view, open the attribute tables of the themes you wish to join. In this 
case type of land use themes and land use of the district themes. 

2. Make the source table active (land use of the district. This is the table you 
wish to link to the other table (type of land use). Click the field’s name to link 
(type). 

3. From the [Table] menu select [Link] 
 

 
 

4. Select open space in the type of land use table, and will be selected all open 
space in the land use of the district. 
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f. Calculating features 

f.1 Calculating area of polygon themes 

1. Open the attribute tables of the themes you wish to calculate the area. In this 
example District boundary themes. 

 

 
 

2. Make the source table active and from the [Table] menu select [Start Editing]. 
The table will enable to make changes. 
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3. From the [Edit] menu, select [Add Fields]. Input the name, type, Width and 
decimal places of the fields, and then click the [OK] button.  

 

 
 

4.  Now you have a table with the new fields to calculate the area of the 
polygons. 

 

 
 

5. From the [Field] menu, select [Calculate]. 
 

 
 

6. In the [Field Calculator] dialog box type [Shape]. Type “ReturnArea”, and 
then click in the [OK] button. 
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7. ArcView calculate the area of each polygon in the table. To save the changes 
in the table select [Stop editing] from the [Table] menu. 

 
   
f.2 Calculating the length of line themes 

1. Same as calculating area, Open the attribute tables of the themes you wish to 
calculate the area. In this example District boundary themes. 

2. In the [Field Calculator] dialog box type [Shape]. Type “Returnlength”, and 
then click in the [OK] button. 

3. ArcView calculate the length of the shape in the table. In the case of the 
polygons, calculate the length of perimeters, and in the case of polyline, 
calculate the length of the line. 

 
g. Getting the X and Y coordinate from point themes 

1. Follow the same step to edit and add fields. 
2. In this example will calculate the X and Y coordinate of the location of 

industries. 
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3. Open the table of industries themes  
4. Add new fields to calculate the X and Y coordinates. 
5. Select the new fields X. 
6. In the [Field Calculator] dialog box type [Shape]. Get X, and then click in the 

[OK] button. 
7. ArcView calculate the X coordinate of the point shape in the table. 
8. Select the new fields Y. 
9. In the [Field Calculator] dialog box type [Shape]. Get Y, and then click in the 

[OK] button. 
10. ArcView calculate the Y coordinate of the point shape in the table. You can 

get a table of each industry with the X and Y coordinate. 
 

 
 

1.1.7 GeoProcessing 

GeoProcessing is a way to create new data based on themes in your view. In most 
cases you will alter the geometric properties of the features in a dataset while 
controlling some aspects of how its attribute data is handled. 
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a. Starting GeoProcessing 

1. From the [File], menu select [Extensions]. 
 

 
 

2. In the [Extensions] dialog box select [Geoprocessing]. 
 

 
 

3. Now you can select [Geoprocessing Wizard] from the [View] menu. 
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4. Then appear the next Geoprocessing dialog box. 
 

 
 

b. Intersecting two themes 

This process is similar to clipping a theme, except it preserves only those features 
falling within the spatial extent common to both themes. The features of the input 
theme are intersected or sliced by the intersect theme. The attribute data from both 
themes are included in the new theme's attribute table.  
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The Intersect process computes the geometric intersection of the two themes and adds 
it to your view as a new theme. The input theme can be a line or polygon theme. The 
overlay theme must be a polygon theme. The overlay theme’s features will split the 
input theme. Any features in the input theme that are not overlaid by features in the 
overlay theme will not be added to the new theme. The output shapefile’s features 
will be of the same type as the input theme features. When intersecting features of the 
input theme with the polygons of the overlay theme, the attribute tables are also 
updated. The attribute table for the output shapefile includes the attributes from the 
input and overlay theme. 

Use the Intersect process when you want to integrate two spatial data sets while 
preserving only those features falling within the spatial extent common to both 
themes. For example you have a land use themes and district boundary themes, and 
you will want to know the exactly area of land use type by each district you had to 
intersect those two themes. 

1. Open the themes to intersect 
2. In the [Geoprocessing], dialog box select [Intersect two themes]. 
3. Select the input theme, the overlay theme and the location of the output file, 

and then click the [Finish] button.  
 

 
  

4. ArcView will processes the intersection and create the new theme. 
 
c. Merging features 

Use the Merge process when you want to create a new theme containing two or more 
adjacent themes of the same shapefile type. For example, you may want to merge or 
append highway data delivered as a series of tiles. Merge allows you to append the 
data while maintaining the attributes contained in whichever shapefile you select. 
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Select themes to merge: Choose two or more themes that are of the same geometry 
type. The Finish button will not be enabled until you have two or more themes of the 
same type selected. You can use the Control and Shift keys in conjunction with your 
mouse click to select more than one or a range of themes. 

Use Fields from: Choose the theme that contains the attributes you want to use in the 
theme that will result from this merge operation. If each of the other chosen themes 
have the same fields, then all cells in the attribute table of the merged theme will be 
populated. If any of the other input themes have additional fields, that data will not be 
included. If any of the other input themes are missing the fields, then no data will be 
added to those fields for the features of the selected theme. 

Note: The dropdown list of available themes will not be activated until two or more 
themes of the same shapefile type have been selected for merging. To select more 
than one theme, you need to hold down the Shift key. 

Specify the output file: Browse for or enter the shapefile name that will be used to 
store the results of the merge operation. 

d. Clipping features 

Use the clip operation when you want to cut out a piece of one theme using another 
theme as a "cookie cutter". For example, you may want to select a county boundary 
from your counties theme to extract the roads from your roads theme to create a new 
theme containing a smaller number of roads. 

For this process you can use the Clip option in the GeoProcessing Wizard, but 
remember to first select the county polygons defining the clip area before starting the 
Clip wizard. Enter the roads data as the input theme and the county boundaries as the 
polygon overlay theme. The clipping theme is used as the "cookie cutter" to clip the 
roads. Then, check the "Use selected feature only" box to use the selected features as 
your clipping area. Then specify the output theme name or use the default name, 
clip1.shp. 
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e. Union two themes 

Use the Union process when you want to produce a new theme containing the 
features and attributes of two polygon themes. Let’s look at using Union to provide 
the basis for performing an erosion analysis of soils during a flood. Some 
combinations of slope and soil type represent high risk for erosion, and knowing 
where these conditions are enables risk assessment of crops. For instance, rocky or 
sandy soil on a relatively steep slope could represent flash-flooding dangers to either 
crop or grazing agricultural activities during rainstorms. 

 
 
f. Assigning data by location 

Use Assign data by location when you want to use a spatial relationship to join data 
from the attribute table of one theme to the attribute table of another theme. 
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Depending on the type of data you have, the join will be one of three types of spatial 
relationships: 'nearest', 'inside', or 'part of'. 

Nearest: If you're assigning data from a point theme to another point theme OR 
you're assigning data from a point theme to a line theme, a 'Distance' field is 
automatically added to the theme you're assigning data to, along with any other data 
in that theme. This 'Distance' field contains the distance to the nearest feature. 

Inside: If you're assigning data from a polygon theme to a point, line, or polygon 
theme, the data will be joined to the point, line, or polygon that is contained by each 
of the polygons. 

Part of: If you're assigning data from a line theme to another line theme, data will be 
assigned from lines that are 'part of' (a sub-set of) the lines you're assigning data to.  

 

 
 

1.1.8 Management of a Table with Microsoft Excel 

To manage ArcView data in to the Microsoft Excel, you can export data from 
ArcView to Excel and make report. 

1. In this example will use the data of land use by district to make a next report: 
Area of type of land use by each district. 

2. Export the ArcView table data in to DBF format. 
3. Open the exported file in Excel. Specified the location and change the [Files 

type] in to dBase files. 
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4. Now you have a data file in Excel to manage, as you want. 
 

 
 

5. From the [Data] menu select [Pivot table report and pivot chart report] 
 

 
 

6. In the [PivotTable and PivotChart Wizard] step 1 dialog box, select the type 
of the data to analyze. In  this case [Microsoft Excel list or database] and 
click in the [Next] button. 
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7. In this step select the range of the data, Excel automatically select the entire 
database. Click the [Next] button.  

 

 
 

8. In this step select the location of the pivot table. You can select the entire 
worksheet or a new worksheet. Click the [Finish] button. 

 

 
 

9. Excel creates the pivot table to manage database and create any type of table. 
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10.  Drop in the row fields Type (Land use type), in the column fields name 
(District name) and in the center the area_m2 to calculate the area of each 
type of land use by district.  

 

 
 

11. Finally you can obtain the follow table. 
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12. Format the number and the border to print. (For more detail about pivot table 
please refer to Excel help files) 

1.1.9 Spatial analysis 

a. Creating themes from external data 

In this example will use the data of air pollution concentration. The database contain 
X, Y coordinate and the concentration in each point calculate by other application 
(air.dbf). 

1. Add the external database. 
 

 
 

2. From the [View] menu, select [AddEvent Theme…], to convert the database 
to themes file. 
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3. In the [Add Event Theme] dialog box, Select the new table, X field (the 
column that contain the X coordinate) and Y field (the column that contain the 
Y coordinate). Click the [OK] button. 

 

 
 

4. ArcView create the new point theme. Activate the new theme in the view. 
 

 
 

5. In this step will create the map of air pollution concentration of each point. 
From the [Surface] menu, select [Interpolate Grid]. 
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6. In the [Output Grid Specification], select as follow. For more detail you can 
change each value in this step. 

 

 
 

7. In the [Interpolate Surface] dialog box, select the method and indicate the Z 
value Field (In this case select Conc, that contain the concentration value) 

 

 
 

8. ArcView create new theme with concentration value that you can display as 
follow.  
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1.2 Database Management 

1.2.1 Hardware 

As regards hardware have settled 1 server and 2 Workstations, printers and other 
devices:  

1. Server 
• Dell PowerEdge 2300 
• Pentium III 500Mhz Processors 
• RAM Memory 512MB 
• Monitor 14’ 
• 4 SCSI HD 18MB 
• FDD 1.44 
• CDR/ 4X 
• CD 24X 
• Tape Back Up 
• Keyboard/Mouse 

 
2. Workstations 

• Dell OptiPlex GX1 
• Pentium III 500Mhz Processors 
• Memory RAM 512MB 
• Monitor 21’ 
• 2 HD SCSI 8MB 
• FDD 1.44 
• CD 24X 
• Keyboard/Mouse 

 
Others devices 

• 1 Plotter HP Design Jet 750C+ 
• 1 Printer HP DeskJet 1120 (A3, 600dpi colour, 7ppp) 
• 1 Scanner Mustek ScanExpress SCSI A3SP 



The Master Plan Study on JICA 
Integrated Environmental Management in Baku City in Azerbaijan Republic  KOKUSAI KOGYO CO., LTD. 

 D1-33 

• 1 Digitizer Calcomp Drawing Board III 34480-H4 (A0 format) 
• 3 UPS PowerCom 

1.2.2 Software 

Software as below was set up:  

1. Server 
• Windows NT Server 4.0 
• Microsoft Office 2000 

 
2. Workstations 

• Windows 98 Second Edition 
• Microsoft Office 2000 Professional 
• Arc View 3.2 
• Arc View Spatial Analyst 
• Arc View 3D Analyst 
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Figure 1-1: GIS Structure at the BCE 
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1.2.3 Using a computer 

All the computers mentioned previously are connected in LAN (Local Area 
Network), so that compatibility of the resources is been able to increase the 
productivity. In the next figure, you can appreciate the configuration of the LAN, 
which is of the type “Star”, with 8 ports hubs, in which can increasing the number of 
workstations according to the necessity. The LAN is of the type Client/Server where 
the Server works with Windows NT 4.0, and the Workstations with Windows 98. 
Necessarily for the effective use of this operating system, that allows a strict control 
of the users and the security of the stored data, and for what valuable data of GIS 
were managed, they will have to be defined following people or users:  

• LAN Administrator: Is the person authorized by the institution for 
manage the whole LAN and it will be the responsible one of 
administering:  

- Users account of the workstation. 
- Manage the permission of the sharing files and folder. 
- The security of the data and hardware. 
- Backup of the data. 
- Configuring the hardware. 

• Users: they are people that will be authorized by the administrator to use 
the workstations and access to the data.  

a. To begin to use the computers, follow the next steps 

1. Turn on the Server (Administrator) 
a. Turn on the UPS connected to the Server 
b. Turn on the Server and wait until Windows NT start the session. 
c. Make sure that the Hub is turn on.  

2. After the Server is started, turn on the workstations (Users)  
a. To start the workstations, make sure that the Server is ready. 
b. To start the session in the LAN, the users should be registered in the 

Server and authorized by the administrator.  
c. Input the user name and the password and then start the session. 

1.2.4 Administering Windows NT Server (Administrators) 

Windows NT is frequently marketed as an operating system that requires little or no 
system administration, this is an ideal honored more in the breach than in reality. 
Well designed system administration tools can go a long way toward making 
Windows NT systems management easy and painless under normal circumstances 
and some of the Windows NT tools come reasonably close to this objective but 
realistically, you can expect the unexpected to occur all too frequently.  

System administrators are distinguished from ordinary users, power users, and 
operators in that they know what to do when things go wrong. While all these classes 
of users are comfortable using the system under normal circumstances, only system 
administrators have to know what to do when things are anything but normal. This 
doesn't mean you have to know the solution instantly for every problem you 
encounter. Sometimes you will, but more often what you bring to the situation is a 
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strategy for figuring out what has gone wrong and the tools for fixing it once you 
have done so. 

Successful system administrators are continually aware that computers are used by 
people and organisations and that managing them cannot be extricated from this 
social context. System administration often involves a tension between authority and 
responsibility on the one hand and service and cooperation on the other. The extremes 
seem easier to maintain than any middle ground; fascistic dictators who rule "their 
network" with an iron hand, unhindered by the needs of users, find their opposite in 
the harried system managers who jump from one user request to the next, in continual 
interrupt mode. The trick is to find a balance between being accessible to users and 
their needs, and sometimes even their mere wants, while maintaining your authority 
and sticking to the policies put into place for the overall system welfare. The goal is 
to provide an environment where users can get what they need to do done, in as easy 
and efficient a manner as possible, given the constraints of security, other users' 
needs, the inherent capabilities of the system, and the realities and constraints of the 
human community in which all of them are located. 

a. The system administrator’s job 

Those area some of network administrator’s job: 

• Installing and configuring computer systems and networks, updating them as 
necessary, and keeping them running properly on a day-to-day basis.  

• Managing users and user accounts, including both the computer-related 
aspects of creating and maintaining user accounts and systems, and 
responding to user requests, questions, and problems.  

• Taking care of the peripheral devices attached to the various computer 
systems (printers, tape drives, uninterruptible power supplies) as well as 
adding or removing them as needed.  

• Overseeing regular system backups, which can range from performing 
backups yourself to designing and implementing a backup plan to be carried 
out by others under your supervision.  

• Ensuring that the systems and networks for which you are responsible are 
secure and that valuable or sensitive data is protected from undesired access.  

• Monitoring system and network activity in order to quickly detect any 
problems related to system security, performance, or general functioning that 
may arise, and then responding appropriately to anything you may find.  

1.2.5 Windows NT Server Network 

A LAN is a group of PCs that have been connected, to make possible the 
communication and to share resources. The LAN based on windows NT Server are of 
the type “Client/Server”, that provides a constant security and consistent for the 
connectivity, that is relatively easy to put into practice and to maintain.  

Windows NT Server requires at least ones “File Server” in the LAN, in which the 
Windows NT operating system is executed. The clients or connected PC’s to the 
LAN can execute another type of operative systems, as Windows NT Workstation, 
Windows 95, OS/2, Macintosh, Unix etc.  
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From the point of view of an administrator, one of the main characteristics is that you 
allow it centralised administration of the account of the users and the problems 
related with the security.  

Some characteristics of a secure Operating System  

• To limit the access to the domain to specific users.  
• To limit the access to the domain during certain hours.  
• To limit the access, for user or for group, to resources of the LAN like files, 

folders and printers.  
• To limit that control type has witch users for files and directory.  
• To rake that action they took in different files or directory or what access it was 

granted or even attempted.  

But with regard to the security one has to keep in mind following. When you 
purchase a padlock from the hardware store, only provides the protection when you 
gives an appropriate uses to the padlock, that is to say that although you has a padlock 
if you forgets to close the padlock anyone can enter. The same thing happens to the 
operating systems, although the operating system gives you options of security, if the 
administrator doesn't carry out a security plan, It won't work.   

1.2.6 Connection of Workstations 

In this section it will be focused to the connection of Windows 98 as Workstation of 
the network.  

a. Installation of the network components 

To setup a PC with Windows 98, as Workstation should settle the following net 
components.  

• Network adapters or Network card  
• Network clients  
• Network protocols  
• Network services  

a.1 Network card 

It is the hardware that serves for the physical connection from the PC to the network, 
for such a reason, it is indispensable. Therefore if doesn't have installed one will buy 
it and to install it as the representative of the manufacturer indicates it. To install the 
network cards it is relatively easy, since Windows 98 have support Plug-and-Play that 
recognizes a new device in the system. Once installed or if already has installed it 
verifies as follows.  

1. Select [Network Neighborhood] and click the right button of the mouse and 
choose [Properties].  
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2. Verify in the following screen that the network card is installed.  

 

 
a.2 Network clients 

They are the types or makers of network that it supports. If in the [Network] dialog 
box, any [Network Client] type is not installed, follow the next steps  

1. In the [Network] dialogs box, click [Add].  
2. In the [Select Network Component Type] dialog box, select [Client] and click 

in [Add].  

 
3. In the [Select Network Client] dialog box, choose in the manufacturers 

[Microsoft] and in the network clients [Client for Microsoft Networks] and 
click in [OK]  
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a.3 Network protocol 

This is that determines how the computers will communicate on the network. There is 
a variety of protocols, but for this network will use TCP/IP. To configure it, follows 
the next steps.  

1. In the [Network] dialog box click [Add].  
2. In the [Select Network Component Type] dialog box, select [Protocol] and 

click in [Add].  

 
3. In the [Select Network Protocol] dialog box, chooses [Microsoft] in the 

manufacturing type and in Network Protocols [TCP/IP] and click in [OK]  
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a.4 Network services 

They are that determine which services will be shared. If you wants to share files and 
printers, it should install the network service. To configure it follows the next steps  

1. In the [Network] dialog box, click [Add].  
2. In the [Select Network Component Type] dialog box, select [Service] and 

click in [Add].  

 
3. In the [Select Network Service] dialog box, select [File and printer sharing for 

Microsoft Networks] and click in [OK]  

 
b. Configuration of the network components 

After installs all the components, you will need to configure the following 
components so that can be connected to the Windows NT Server.  

b.1 Client for Microsoft networks 

To configure this component, follow the next steps  

1. In the [Network] dialog box select, [Client for Microsof Network] and then 
click in [Properties]. 
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2. In the [Client for Microsoft Network Properties] click in [Log on to Windows 
NT domain] to enable this option and in [Windows NT domain] type the name 
of the domain of the Server, in this case “DOMAIN”, because it was 
configured this way.  

 
3. Click in “OK”, to finish the configuration.  



The Master Plan Study on JICA 
Integrated Environmental Management in Baku City in Azerbaijan Republic  KOKUSAI KOGYO CO., LTD. 

 D1-42 

b.2 Configuring the protocol TCP/IP 

To configure this component, follow the next steps. 

1. In the [Network] dialog box select, [TCP/IP] and click in [Properties]. 
2. In the [TCP/IP] dialog box, select the [IP Address] windows. Click in 

[Specify an IP address], to enable this option and then type [IP address] and 
the [Subnet Mask].  

 

 
3. With regard to the address of IP, each network should to decide for an IP 

address. In this network the follows will be used as IP address:  
IP Address for work stations 192.154.0.11 up to 192.154.0.99  
Subnet Mask 255.255.255.0  
With regard to these addresses they will have to leave modifying according to 
growing the network.  

4. Click in [OK], to finish the configuration.  

b.3 Configuring the identification in the network 

So that you can work inside the network it will configure the identification of the 
computer, follow the next steps.  

1. In [Network] dialog box select, the [Identification] windows. In [Computer 
Name] type the name that will identify the Computer inside the network, in 
[Workgroup] type the same domain that configured in the Server, in this case 
“DOMAIN” and then type the description of the computer in [Computer 
Description]  
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2. Click in “OK”, and then restart the computer so that all the changes have 

effect.  

c. How to register in the Windows NT Network 

Once it has been added and configured the components, it will restart the computer 
and then follow the next steps.  

1. When the computer starts, the registration dialog box will appear in the 
screen.  

2. Before registering makes sure that the Server is turn on, and the [Username] is 
registered in the domain of the network.  

3. In the registration dialog box, type the [User Name], the password [Password] 
and the domain of the Server [Domain], in this case “DOMAIN.”  

 

1.2.7 Administering the Windows NT Server 

Part of all network administrator work; it is the administration of who access to the 
server. This task also forms the base of the security of their system. In fact, to grant 
access to a system is the first point of verification of any plan of security. Windows 
NT includes an Administration of users with complete characteristics that it allows 
you to create and to administer users' account, the same as users' groups. 

a. Understanding of the domains 

A domain is the main base of a Microsoft NT Network. In a basic way a domain is a 
group of computers and related network resources. At least one of the computers 
should be Windows NT, but it could have many more servers in the domain. Because 
the domain is a logical organisation it doesn't have geographical limits. This means 
that a single domain could be in the same room, in the same building or disseminated 
along the city or all over the world.  
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If it is familiarized with Internet it can confuse a Microsoft network domain with a 
domain of Internet. Although these can be parallel organisations of computers, both 
are not exactly the same thing. In the world of Internet their domain identifies it from 
the rest of the world, as long as a Microsoft network domain is used strictly to handle 
users and the resources to those that users can have access.  

To establish a domain it needs at least one Windows NT Server. This system acts as 
the Primary Domain Controller (PDC) of the domain. This system acts as the place of 
all the information related with the users and the resources for the domain.  

b. Understanding the users and groups 

Inside a domain of the Windows NT network are available four specific elements:  

• Servers: These are computers that execute Windows NT Server and they 
make that the information and the resources are available for the domain.  

• Workstations: These are the computers that, when executing a variety of 
operating systems, they have access to the information (and in occasions they 
provide it) that is available in the networks.  

• Users: These are individuals, people that are entitled to use the workstations 
or the Servers to have access to the resources of the net. The users for the 
general one are limited regarding the access that you can have in the network. 
The users are assigned in a account of the Server and each one obtains a name 
and a password, with each can access to the network.  

• Groups: These are combined administrative of users. The groups allow the 
categorisation and they simplify the administration of the users. The account 
of the individual users can be assigned to different groups of users. When 
belonging to user's group, automatically the account has certain access to data 
and resources of the network.  

c. Administering users manager for domain 

One of the responsibilities of the network administrator is to settle down directive for 
the account. To administer the users account it will use the tool [User Manager for 
Domain].  

1. Select [Programs], in the [Start] menu. 
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2. Select [Administrative Tools (Common)], and then [User Manager for 
Domain] and then appear the next dialog box [User manager-Domain].  

 

 

d. Administering the users account 

As network administrator, one of their big works is to maintain a precise and 
up-to-date database of users. It should be necessary to maintain the security of their 
place and it should be up-to-date so that they are easier their administrative tasks.  

1. Select [Programs], in the [Start] menu, and select [Administrative Tools 
Common]. 

2. In the [User Manager-Domain] windows, select [New User] in the [User] 
menu, and then appear the next [New user] dialog box, where will add a new 
user. 
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When add a new user account, is not a lot of information that is necessary. As 
minimum it needs to assign the user's name [Username], the password 
[Password] and to confirm the [Confirm Password]. Besides the minimum 
information it can add the rest of the additional information.  

Users Must Change Password at Next Logon. If this option is selected, the 
user will modify when he registers for the first time in the network. This 
means that the passwork that is provided in the dialogue box of  [New User] 
it is temporary, effective only to register for the first time. With purpose of 
security it is good decision to select this option.  

User Cannot Change Password. If this option is selected the user won't be 
able to change his own password. If the password expires, it will be changed 
here in user's administrator.  

Password Never Expires. If this option is selected the user will never need to 
change the password. This option annuls the directive ones for the account 
where it specified since time was effective the password.  

Account Disable. This option can be used to disable a account temporarily. In 
an automatic way this option is selected if the user has designated temporally 
and the time of expiration of the account has been exceeded.  

3. In the inferior part of the dialog box of [New User] they are some button, 
which allow specifying additional information to the account.  

4. After specifying the user's information, make click in [Add] to add a new user.  

e. Administering user’s groups 

Groups contain users or other groups; give members the permissions that belong to 
the group provide easier management of users. There are three main groups used in 
Windows NT Server. 

• Local Groups: Are used to assign permissions in the local domain. Can 
contain users and Global groups, including Global groups from other trusted 
domains.  

• Global Groups: Contains user accounts only. Used to export user accounts to 
other domains, where they can be imported into Local Groups on trusting 
domains  

• Special Groups: Used by Windows NT Server for system access, and do not 
contain user or group accounts. 

e.1 Global groups 

Global groups contain users from the local domain. They are also used to export users 
to another trusting domain. Global groups do not have rights to perform any 
administrative tasks. For instance, the built-in global group Domain Admins can only 
perform administrative tasks if it is made a member of the local group 
Administrators.  

e.1.1 The built-in global groups 

The following table lists the Global groups built-in to Windows NT Server. 
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Global Group Name Members  Who can modify? Initially member of  

Domain Administrator Administrator Administrators Administrators 

Domain Guests Guest 
Administrators  

Account Operators 
Guests 

Domain Users Administrator 
Administrators  

Account Operators  
Users 

 
e.1.2 How to use groups in domains 

Let's consider some recommendations concerning the use of Global and Local group 
memberships as outlined by Microsoft.  

Function Group to use 

Export users to another domain Global  

Assign permissions and rights to local domain resources  Local 

Give rights to users from another domain Local 

Combine groups Local 

users need access to Windows NT Workstations or NT servers in a domain  Global 

 
e.1.3 Add global groups 

1. To add a new group of users it simply selects the option in the menu [Users] 
of the dialog box [User Manager Domain].  

2. If it needs to add a global group select [New Global Group].  
3. To define the global group it simply provides a name for the group and an 

optional description, select the account of users that you want as the members 
of the group.  

4. To add members select the user's name in the list [Not Members], and then 
make click in Add, so that they are [Members].  

5. When it finishes defining the group click in [OK]. The new global group will 
appear in the inferior part of the [User manager].  

e.2 Local groups 

Local groups are limited to the domain [or computer] they are created on. They are 
created using User Manager, and a number of pre-existing Local groups have been 
provided.  

Local groups created on a Windows NT Server [non BDC or PDC] or Windows NT 
workstation are limited to that computer only. In contrast, a Local group created on a 
domain controller can be used on any server, which is a member of that domain, but 
cannot be used outside the domain.  

e.2.1 The built-in local groups 

Microsoft recommends that you use the existing Local groups where possible. The 
following table lists the Local groups built-in to Windows NT Server.  



The Master Plan Study on JICA 
Integrated Environmental Management in Baku City in Azerbaijan Republic  KOKUSAI KOGYO CO., LTD. 

 D1-48 

 

Available on Local Group Name Members Who can modify? Rights 

DC Account Operators 
(AO) 

None  Administrators  
Account Operators  
Server Operators  

Create, Delete, Modify user accounts 
and groups.  
Cannot modify the Administrator or 
Server Operator groups  

W+S+DC Administrators (AD) Domain   
Administrator 

Administrators  Create, Delete, Manage user accounts 
and groups.  
Share directories and printers.  
Grant resource permissions.  
Install OS files and programs.  

W+S+DC Backup Operators 
(BO) 

None Administrators Backup and Restore servers.  
Logon locally.  
Shut down the server.  

W+S+DC Guests (G) Guest  Administrators  
Account Operators 

 

W+S Power Users    

DC Print Operators (PO) None  Administrators Share and remove sharing printers.  
Manage printers.  
Logon locally.  
Shut down servers.  

W+S+DC Replicator None  Administrators  
Account Operators  
Server Operators  

Used with the Directory Replication 
Service.  

DC Server Operators 
(SO) 

None  Administrators Share and remove sharing resources.  
Format the server disks.  
Logon locally.  
Backup and restore servers.  
Shut down servers.  
Lock and unlock servers.  

W+S+DC Users (U) Domain Users  Administrators  
Account Operators 

 

W=NT Workstation 
S=Windows NT Server 
DC=Domain Controller 

e.2.2 Default rights for built-in local groups on Windows NT Server 

The following rights are visible in User Manager for Domains.  

Rights AD AO BO E G PO SO U 

Access this computer from the network Yes    Yes     

Backup Files and directories Yes  Yes    Yes  

Change the system time Yes      Yes  

Force shutdown from remote location Yes      Yes  

Logon locally Yes Yes Yes   Yes Yes  

Manage auditing and security log Yes        

Shut down the system Yes Yes Yes   Yes Yes  

Restore files and directories Yes  Yes    Yes  

Take ownership of files Yes        
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The following rights are NOT visible in User Manager for Domains [defaults which 
you cannot change].  

Rights AD AO BO E G PO SO U 

Assign user rights Yes        

Create and manage user accounts Yes Yes       

Create and manage global groups Yes Yes       

Create and manage local groups Yes Yes      Yes 

Create common groups Yes      Yes  

Format the servers hard disk Yes      Yes  

Keep local profile Yes Yes Yes   Yes Yes  

Lock the server Yes   Yes   Yes  

Share and stop sharing directories Yes      Yes  

Share and stop sharing printers Yes     Yes Yes  

Unlock the server lock Yes      Yes  

 
If you unlock a server that has been locked by another user, any work in progress will 
be lost.  

Users will only be able to add local groups if they have access to User manager for 
Domains.  

Everyone has the right to lock a NT Server, but does not have the right to logon 
locally. 

e.2.3 Add a local group 

1. To add a local group of users, selects (File, New, Local Group).  
2. The information that provides to create a local group is almost the same one 

that used to create a global group, but a difference exists in the form of 
making it.  

3. When it adds the initial members to the first local group makes click in [Add] 
and then the [User Manager], it shows the new dialog box that has a list of all 
the global groups and users' account in the system.  

4. The local groups allow you to define a global group as members, to add the 
members it simply selects the names in the superior part of the dialog box and 
then make click in [Add].  

5. Click in [OK] and the names that it specified are added to the new local group 
as initial members.  

6. When it finishes defining the local group, click in [OK].  

f. Sharing files and folders 

1. Creating a share under Windows NT is quite easy, simply find the folder you 
want to share, right-click, and select the menu option labeled "Sharing". 
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2. A dialog box will pop up with a tab entitled "Sharing" selected.  This is the 
exact same panel that comes up if you right-click a folder and select 
"Properties" - the only difference is that the "Sharing" tab is pre-selected for 
you.  Click on the "Shared As" radio button.  The "Share Name" field will 
automatically be filled in with the same name as the folder, but you can 
change it. 

f.1 Share and permissions 

Many Windows NT administrators I've met are very confused about how share 
permissions work.  The basic problem is that there are two types of permissions 
involved - share and file permissions. First, some definitions: 

• Share Permissions: These are the permissions for who is allowed to connect 
to that share, and what they are allowed to do in that share (i.e., only read 
files, change files, create and delete files, etc.).  Share permissions only apply 
when connecting to shares over a network.  Shares are not used at all when 
connecting to files on the computer you are currently on (Microsoft calls this 
"logged on locally"). 

• File Permissions: These are Windows NT security file permissions, which 
apply to files at all times (whether connecting remotely or locally).  These 
permissions specify who can access that file or folder, and what they can do to 
it (i.e., only read files, change files, create and delete files, etc.). To set these 
permissions, you must be using NTFS.  If the drive/partition is formatted as 
FAT, file permissions cannot be set. 

When a person attempts to connect to a share to read a file, NT does the following 
(and denies access if any check fails): 

• Checks to see if that user has permission to connect to the share  
• Checks to see if that user has read access to the share  
• Checks to see if that user has file permissions to that file in the share  
• Checks to see if that user has read access to that file in the share  
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As you can see, a lot of checks are done.  Basically, Windows NT is going to apply 
the most-restrictive rules when granting access to files. 
By default, when you create a share Windows NT sets the share permissions to 
"Everyone/Full Control".  Go back into the Sharing properties of the share created 
previously, and this time click the "Permissions" button.  It should look like this: 

 
 
I call this default "pass through share security", because it is simply letting anyone on 
your network connect to this share (whether in your domain or not!), and granting 
them full control over the files there. Remember, though, that if you are using NTFS, 
they must also have file-level permissions to really access the files. 

If you are familiar with file-level permissions (and you certainly should be), you'll 
notice that this panel is nearly identical to the one used for setting file-level 
permissions. Using it, you can define who is allowed to access this share.    

Examples. 

For example, say you have a folder named "test1" with three files in it, FILE1, 
FILE2, and FILE3.   

You set up a share granting EVERYONE full control. However, on each file you set 
it to be full control for administrators, and No Access for domain users. What 
happens when a user connects to that share?  They can connect, and see the file 
names, but attempts to do anything result in an 'access denied' on the file. 

If you then changed FILE2 to be full control by everyone, than anyone could use it - 
but not files FILE1 and FILE3. This works the other way around, too.  Assume you 
then set all three files to Full Control by Everyone via file permissions.  You then 
change the SHARE permissions to only allow Read access by Domain Administrators 
(no other access).  Here's what would happen: 

• Domain administrators can connect to the share. When connected to the share, 
they can ONLY read the files. (Note that if they log on locally to the system, 
they don't need to use a share, and they have Full Control) 
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• Domain users can't connect to the share at all. Like Domain Administrator, 
they have full control over the files IF they are logged on locally to the 
computer, since the files are set as Full Control. 

g. Sharing printers 

1. Select [Setting] from de [Start] menu, then select [Printer]. 
 

 
 

2. In the [Printer] folder, select the printer to use in the LAN, the click the right 
mouse button, and then select [Properties]. 

 

 
 

3. In the printer [Properties] dialog box, select the [Shared as] option and then 
type the [Share Name], and click [OK] 

4. Now this printer is available for all in the LAN. 
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